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 Monthly Newsletter of the Redlands Camera Club

           August 2022
                    Photogram Editor – Debra Dorothy

               Deadline for entries is the 25th of every month

Redlands Camera Club meets: 1st (Held in person) & 3rd (Held via Zoom)

Mondays  7:00 pm 
Check http://www.redlandscameraclub.com for Zoom meetings

             Guests are always welcome

             Photo by Nick Koller
          

ColorMunki – Have your photos submitted for QuickPix, Members’ Night, or competitions not looked the 
way you expected? The problem is probably a difference in how your computer and the club projector 
display colors and brightness. You can fix this by calibrating your computer the same way our club 
calibrates our projector – with the ColorMunki. Set up is simple and the calibration process only takes a few
minutes. Contact Carl Detrow at csdetrow@verizon.net  to reserve the ColorMunki.

Want to learn more about your hobby?
Click the link below to go to B&H Learning Video Site:

 

Click HERE

http://www.redlandscameraclub.com/
../../../../../../www.bhphotovideo.com/explora/videos
mailto:csdetrow@verizon.net


President’s Message – Russell Trozera

The Redlands Camera Club recently completed their 2022 Summer
competition.  There  were  lots  of  wonderful  images.  I  would  like  to
paraphrase  what  Bob  Fletcher  one  of  our  judges  said,  at  the
conclusion of the Summer Competition.

“I  have been judging Redlands for a long time and you guys have
done a terrific job of educating your people. Helping them to perfect

the craft of photography. I have seen major improvement in the overall images. I have
been  judging  the  competition  more  on  a  professional  level.  I  used  to  judge  the
competition on an amateur level, but most of your people have improved dramatically.” 

So what does it take to become a good photographer? Its not the equipment though it 
helps. It is the desire to go beyond just taking a picture. It is applying the basic guide 
lines, patience, then taking lots of pictures. It going out with a purpose as you 
photograph whether to take better family photographs, birds in flight, capturing the 
moment or standing in front of awesome places trying to capture what the eye sees.

Just remember the more you snap the greater opportunity you have to capture great 
images

One might ask, 

“Which of the photographs is my Favorite? The one I’m going to take tomorrow”. 

                                                                              Imogen Cunningham

 

Have a good time taking photos

 

Russ Trozera

Photo by Judith Sparhawk
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       Vice President/Program Chair – Bruce Herwig

“Shooting Iceland”
Russ Trozera and Wayne Purcell 

Redlands Camera Club, August 1, 2022, 
an IN-PERSON Meeting and also a Zoom Meeting.

Description- Do you like photographing waterfalls, picturesque churches, glaciers, volcanoes,
sheep,  rocky  shorelines,  puffins,  and  the  Northern  Lights?  Then  you  might  like  shooting
Iceland. Russ Trozera and Wayne Purcell took two very different trips there, one in the winter,
one in the summer, and will talk about ways to plan such a trip, sharing their photos as they
do.
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August 15, 2022
Ralph Nordstrom will present a

Zoom Meeting
“The Shoulders On Which We Stand”

In the early days of photography the general idea was that since cameras were
mechanical devices photography would never be able to create art. The debate
went on for decades. 

However, some of the greatest photographers and artists that ever contributed
to photography were intent on proving that photography is a powerful art
form. 

In this presentation we will look at the masters that turned those early days of
photography into an art form that we benefit from today.

Bio
I was raised in an outdoor family and had a father who painted and loved photography. So, it’s natural
that I have a keen love for nature and am drawn to landscape photography. My goal in landscape
photography is to create expressive images that connect with my viewers. I also am passionate about
sharing what I’ve learned over the years with workshops in some truly spectacular locations.

          

                               Imogene Cunningham
                                      (self portrait)
             
                                                                                                                                      Gertrude Kasebier  

                            
                                                                                                                        

                   

                  

                      Edward Weston
                                                                               Henri Cartier-Bresson
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Competition Chair – Carl Detrow

RCC Summer 2022 Competition Update

What a fantastic summer 2022 competition we had! The Category X of
“Inspiration” was clearly the most popular special  category ever, and
many members showed exceptional  creativity  in  combining excellent
images with thoughtful words. 

Best of Show was a clear winner. The competition video should be on
the website by now. (Thanks, Russ, for editing it.) Congratulations to all
who entered.  

Awards for all classes and categories will be announced at the August 1 in-person meeting,
which we will also attempt to broadcast by Zoom. Hopefully we have the glitches ironed out. 

Our next competition will be for the winter quarter, to be held in the November-December time-
frame. Further details will be announced soon. If you have an idea for the next Category X, let
me know. The last Category X was member-sourced, and it was better than anything we’ve had
before, so I’m looking forward to your suggestions.

                                    

      

Photo by Jim Selby
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Publicity Chair--Mike Livingston 

RCC members win awards in 
Redlands Conservancy Photo Contest

Last month, Redlands Conservancy announced the winners of its
first ever photo contest. Photographers of all skill levels had taken
to capturing Redlands “through the lens of conservation.” It should
come  as  no  surprise  that  ribbons  were  awarded  to  several
Redlands Camera Club members.

Please join me in congratulating Judith Sparhawk, David Card, Jim Hendon, and Bruce Herwig.

Winning the Community Vote, Judith Sparhawk for First Snow of Winter:

In the History category, 2nd Place goes to David Card for A Spectacular Finale:

3rd Place in the History category goes to James Hendon for Madonna Statuette:
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And in the Landscape category, 1st Place goes to Bruce Herwig for Ominous & Beautiful:

Photo by Jim Hendon
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Membership Chair – Stephanie Billings

MEMBERSHIP DUES ARE STILL COMING IN

 MEMBERSHIP DUES ARE STILL COMING IN

Yearly Membership Renewal – Dues continue to come in for this fiscal year BUT there
are still many members who have not responded. Please make a concerted effort to renew
your  membership  as-soon-possible.  It’s  easy  just  go  to  the  Redlands  Camera  Club
homepage and click on the new membership or renewal tap at the top of the page, then

simply scroll down, and click on renew and pay via PayPal, that’s it!

$35.00 is a great deal for all the benefits that Redlands Camera Club offers. Only currently paid members can
take  part  in  education  classes,  competitions,  events,  free  workshops,  field  trips  AND soon  to  be  revised
Membership Night!                                                               
 
Let’s welcome all the new members that have joined RCC this year:
Dave Card
David Farugia
Cynthia Howard
Maribel Lawson
Susan Leonard
Michael Livingston
Carey VanLoon
Robert Walls
Susan Wilbur

Contact Stephanie Billings at:HeartandSoul4@yahoo.com if you have any questions about your membership 
renewal.

Thank you,

Stephanie Billings
RCC Membership Chair

                     Photo by Stan Fry
                                        

                            
                                        
               

                                                                                                  Photo by Jim Hendon
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Here’s What I Think! 
This article covers different Adobe Photoshop/Lightroom tips, tricks and
techniques.  The views expressed in this article are those of the author and
do not necessarily reflect the views of Redlands Camera Club.

By John Williams
Need help?  If you have any questions about processing an image using Adobe Lightroom
or Photoshop, email me at jhwr@earthlink.net (for RCC members only) and I will try to
assist you.

PHOTOSHOP TIPS
How to Remove the Background Quickly:

 Open your photo into Photoshop and then duplicate the Background Layer (Ctrl+J)

 Click on the Properties tab (red arrow in figure below).  Expand the Quick Actions (red rectangle) and 
depress the Remove Background tab.  A mask will be added to your duplicated layer revealing your main 
subject.  

 Turn off the Visibility icon on the Background layer and click on the Mask.  Refine the Mask by painting 
with white to add areas or Black to hide areas.

Difference between Opacity and Fill in the Layers panel:   The Opacity is responsible for the transparency of
the entire layer, including all effects applied to it.  Fill is responsible only for the pixels on the layer, ignoring 
any layer styles applied (e.g., Bevel & Emboss, Stroke, Drop Shadow, etc.) to the layer.
OPACITY VS. FLOW: The debate goes on and on. Should you use Opacity or Flow when you want to build 
up brushstrokes in Photoshop? If you’re looking for a very flat, even result, use Opacity because it will apply 
color at the same amount, and won’t surpass the current Opacity value no matter how many passes you make 
over the same area. You have to release the mouse button or raise your pen from your tablet and then apply a 
second stroke to build up the color.  Flow on the other hand, will keep applying color as long as your finger is 
on the mouse button, so you can make multiple passes over the same area to build up the color.  Flow is the best
for shading, because it produces a smoother result.  So basically, if you want shading, use Flow, if you want a 
flat color, use Opacity.

LIGHTROOM TIPS
Instability And Crashes:
A variety of software applications—including Adobe—make use of the Graphics Processor Unit (GPU) to 
improve performance. However, in some cases enabling this feature can lead to instability and crashes. As a 
general rule, whenever there are odd issues or crashes with a software application that includes GPU support, 
try disabling that GPU support as a troubleshooting measure.
In Photoshop you can disable the GPU in the Preferences dialog. Start by selecting Edit > Preferences > 
Performance from the menu on Windows, or Photoshop > Preferences > Performance on Macintosh. Turn 
off the "Use Graphics Processor" checkbox in the Graphics Processor Settings section and click the OK button 
to apply the change. Then quit and restart Photoshop.
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In Lightroom Classic go to the menu and choose Edit > Preferences on Windows or Lightroom Classic > 
Preferences on Macintosh. On the Performance tab set the Use Graphics Processor popup to "Off". Close the 
Preferences dialog and restart Photoshop or Lightroom Classic.
After disabling the GPU in Photoshop and Lightroom Classic, the crashes should stop happening. You can then 
upgrade to the latest versions of each application to confirm the problem won't recur with those updates, as long
as you keep GPU support disabled.  Hopefully in the next upgrade to Lightroom Classic/Photoshop the problem
will be corrected allowing you to reenable your GPU.
How to move your photos with Lightroom edits from my travel laptop to your  home 
computer?

 Right-click on your laptop collection.  Choose Export this Collection Set as a Catalog.

 A window will popup.  At the bottom check:

 Export negative files.

 Include available previews.

 Plug in your external hard drive into your laptop travel computer.

 You will want to transfer the following files to you home computer:

 Plugin your external hard drive into to home computer.

 Open Lightroom classic and choose File>Import from Another Catalog.

 A new window will launch where you select where you want to save your new photos.
How many catalog backups should I keep?  It’s a great idea to back up your catalogs in Lightroom 
Classic. To set it up, go to the General tab in Lightroom Classic (PC: Edit)>Catalog Settings. I recommend you 
set to back up weekly upon closing LrC.  Each time it does this backup, it checks the integrity of the catalog, 
optimizes it, and then compresses a copy of it to your designated folder, which means that each week you are 
going to have a new copy of your catalog in that folder. Those files will add up quickly and take up space on the
hard drive. Also at some point, the older backups are going to be so old that you wouldn’t want to use them 
unless you absolutely had no choice. 
I keep only the three latest backups.
Shortcuts keys you should memorize and use:

1. G – This instantly returns you to the Library Module and the Grid view of all my thumbnail images.

2. Shift-tab – This hides all the panels and lets you see your image really large

3. D — This takes my image quickly over to the Develop module for editing.

4. Command-E on Mac (Ctrl-E on Windows) – This takes your image over to Photoshop to do some 
editing over there.

5. F – This gives you a full-screen view of your image and Lightroom is hidden from view.

6. P / X / U – These are the letters to use when you cull through a shoot. P marks the shot as a “Pick” (a 
keeper). X marks the photo as a reject. U is what you hit if you made a mistake or changed your mind.  It 
“undo’s” my P or X.

7. Command-N (Windows: Ctrl-N) – This creates a New Collection from your selected photos.

8. V – Tapping this key shows what the image would look like in Black and White, so you can see if it’s 
even worth going through a full black and white conversion. To switch it back to color, tap “V” again.

9. To Reset any slider, double-click on the slider’s name. When you’re using the Adjustment Brush, to reset
all the sliders to zero, double-click directly on the word “Effects.”

10. To change brush sizes, pressing the left bracket key [ makes the brush smaller in size, and the right 
bracket key ] makes it larger.

11. Press the Backslash key (\) to see a before/after of your image.

12. Press Y to see a side-by-side before/after preview of your editing. Press Y again to return to your normal 
view.

How to download the images from the James Webb Space Telescope (JWST) and other images from NASA:
Open the following web page http�s://webbtelesco�e.org/resource-gallery/images 
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Member Recognition's 

    Photo 
       by 
Keith Hong
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Announcements

New – Personal Lightroom Coaching with John Williams

Contact  John Williams for some over-the-shoulder coaching in photo editing,  a  great way to
learn.  Using  your  selected  images,  John  will  work  with  you  at  your  level  to  improve  your
understanding of key tools and techniques to make the most of your photos. John is a regular
contributor  of  articles  on  Lightroom  and  Photoshop  to  the  RCC  Photogram.  Reach  John  at
jhwr@earthlink.net or talk to him at our meetings. 

RCC Members: Unique opportunity to make a difference
Frank Peele, Education/Workshops Chair

Museum of Redlands
This newly-established museum needs quality photography of items in its collection, and has asked
RCC for support. This sounds like a win-win situation, both for the museum and for our members
who  want  to  develop  skills  in  “product”  photography.  I  envision  a  workshop  to  teach  the
fundamentals,  and  one  or  more  shooting  sessions  to  get  into  creating  great  images  for  the
museum’s use. If you’re interested in being part of this service to the community, or just want to
find out more about the opportunity,  shoot  me an email:  educationworkshopsrcc@gmail.com
Thanks, Frank
__________________________________________________________________________________
Film cameras and Lenses Needed 

A group of photo-enthusiasts at Riverside Community College needs FILM cameras and lenses to
use in their studies. If you have such equipment you’re willing to donate to a worthy cause, please
contact RCC member Constance St Jean and let her know what you have. Contact her by email at
constancestjean@gmail.com
__________________________________________________________________________________

A 35 mm slide and negative digitizer, a Wolverine F2D, has been generously donated to -the club
by member Dave Knapp. It will produce a 7 mb JPEG digital image from your black and white and
color slides and negatives. If you are interested in borrowing it from the club, email  Wayne Purcell
at waynepurcell72@gmail.com or text him at (909) 664-4365.

       

     Photo 
       by 

        Kelly Tilson
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Photogram Editor – Debra Dorothy

A Note from The Photogram Editor

The theme for the Septembert Photogram is
“Color”

Please send your images to me by August 25th to have them included in the September Photogram for all to
enjoy.

mailto:debbiedsd.dorothy@gmail.com

Redlands Camera Club P.O. Box 7261 Redlands Ca 92375
http://www.redlandscameraclub.org/

Officers (2020-2021)
President: Russell Trozera – Vice President/Program’s: Bruce Herwig– Secretary: Deborah Seibly –

Treasurer: Rick Strobaugh – Past President: Dave Ficke

Chairs (2020-2021)
Competitions: Carl Detrow – Education/Workshops: Frank Peele – Facebook/Blog: Stan Fry – Field

Trips: Donald Purdy – Historian: Carol Abidin – Membership: Stephanie Billings – Mentor: Rick
Strobaugh – Photogram: Debra Dorothy – Publicity: Stan Fry – S4C: Deborah Seibly – Color Munki:

Carl Detrow – Webmaster: Debra Dorothy – Welcome: Stephanie Billings - Publicity: Mike Livingston –
Board Member: Frank Peele
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